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MicroStation II Tutorial

Es wird in diesem Tutorial angenommen, dass Sie das MicroStation I Tutorial erfolgreich abge-
schlossen haben und die darin beschriebenen Konzepte und Befehle beherrschen. Dieses Tutorial
konzentriert sich auf vier wichtige Themen.

- Bestimmung von Betrachtungspunkten. Ein Model kann von allen möglichen Stand-
punkten aus betrachtet werden. Diese Punkte können mit Kamerastandpunkten vergli-
chen werden, d.h. eine Änderung des Blickwinkels ändert nichts am Modell selbst.
- Paralleles Arbeiten in mehreren Fenstern. Um erfolgreich in drei Dimensionen arbeiten
zu können, ist es oft notwendig, das Modell von mehreren Blickpunkten gleichzeitig zu
betrachten.
- Modellieren in 3D. MicroStation gibt verschiedene Hilfestellungen, um Objekte im 3D-
Raum zu manipulieren. Dazu gehören das ACS - "Auxiliary Coordinate System", mit dem
die x-y Ebene im Raum definiert werden kann. Die schon bekannten Befehle MOVE,
COPY, usw. sind nun im neuen ACS ausführbar. Daneben ist AccuDraw, der intelligente
Cursor, den Sie schon im 2D Tutorial kennengelernt haben, in der dritten Dimension erst
recht ein sehr wertvolles Werkzeug.
- Levels (Ebenen) sind wirksame Werkzeuge zur Organisation Ihrer Modelle. Sie sind in
den meisten CAD-Programmen vorhanden. Sie werden in diesem Tutorial lernen, wie
man einige dieser Level-Methoden anwendet.

Wenn Sie im Tutorial aufgefordert werden, etwas einzugeben, tippen Sie die Buchstaben und/oder
Zahlen ein, die sich zwischen den "[" und "]" Zeichen befinden. Jede Eingabe muss mit der RETURN
Taste abgeschlossen werden. Zusätzliche RETURNs werden explizit erwähnt. Benützen Sie die Be-
schreibungen der früher ausgeführten Tutorials und folgen Sie den Aufforderungen auf der Kom-
mando Linie.

MS_2 Modell kopieren

wo Home Directory Fenster
was Ausgabe-Folder doppelklicken. Selektieren Sie das Ikon für das ms_2.dgn, schieben Sie

das Ikon vom Ausgabe-Directory in das tutorials-Directory (im Home Directory Fenster)
und klicken Sie auf den Copy-Knopf im erscheinenden "File Manager Information"
Fenster. Das tutorials-Directory öffnen und das File ms_2.dgn als a2_nachname.dgn
umbenennen.

bem Schreiben Sie alles klein, mit Unterstrich statt Leerstelle und mit der Endung ".dgn", damit MicroStation das File wiedererken-
nen kann. Überall wo "nachname" geschrieben ist oder verlangt wird, ist Ihr eigener Nachname einzufügen.
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MicroStation starten

wo Home Directory Fenster
was Das File a2_nachname doppelklicken. Automatisch wird MicroStation mit der entspre-

chenden Zeichnung aufgestartet.
bem Das Programm kann auch aus der Toolchest unter "APPLICATIONS" "MICROSTATION" gestartet werden.

Key-In und AccuDraw Koordinatenzeiger einstellen

Im ersten Schritt bereiten Sie Ihre Arbeitsumgebung vor.

was Starten Sie das key-in Feld ("Utilities" > "key-in").

 Wenn Sie das "key-in" Fenster zum ersten Mal öffnen, wird eine Dialogbox geöffnet. Sie
benötigen jedoch nur das Eingabefeld, welches nach dem Andocken sichtbar bleibt.
Starten Sie AccuDraw  (siehe Tutorial I).
Docken Sie die Eingabefelder unten an Ihrem
Arbeitsfenster an.

bem MicroStation behält immer die Einstellungen, die zuletzt, d.h. das letzte mal als Sie das Programm benutzt haben, aktiviert
waren.

VIEW SAVE: Speichern einer Ansicht

Als erstes werden Sie die Ansicht in diesem Fenster (Arbeitsfenster 1) speichern. In MicroStation
gibt es die Möglichkeit 8 Arbeitsfenster zu öffnen. Die Ansichten der verschiedenen Arbeitsfenster
können gespeichert werden und jeweils auf andere Fenster angewendet werden. Geben Sie dafür
jeweils die Nummer des Fensters an, dessen Ansicht gespeichert werden soll. Wenn Sie die Ansicht
auf ein weiteres Fenster übertragen wollen, geben Sie unter "Dest View" die Nummer der ge-
wünschten Ansicht ein.

wo "Utilities" > "Saved Views"
was Geben Sie in der Dialogbox  den Namen [axo1] und

den Kommentar [axo_view] ein und speichern Sie.
Lassen Sie die Dialogbox geöffnet.

bem Sie haben die aktuelle Ansicht abgespeichert, und können später auf sie
zurückgreifen.

Zweites Fenster öffnen

Im Gegensatz zum ersten Tutorial, in dem nur in der Plandarstellung gearbeitet wurde, haben Sie
es diesmal mit einem dreidimensionalen Modell zu tun, von dem Sie eine axonometrische Darstel-
lung sehen. Als erstes öffnen Sie jetzt ein zweites Fenster, in dem Sie eine andere Ansicht wählen.

was Wählen Sie im Menu "Window" > "Open/Close" > "2". Ein zweites Arbeitsfenster wird
geöffnet.

bem Der Übersicht wegen werden Sie selten mehr als 4 Arbeitsfenster gleichzeitig geöffnet haben, interessant ist allerdings, dass ein
Fenster sich seine Einstellung merkt, auch nachdem Sie es wieder geschlossen haben. Bei komplexeren Modellieraufgaben
kann es deshalb durchaus vorteilhaft sein, alle acht Fenster zu verwenden. Die einzelnen Arbeitsfenster sind nummeriert, falls
keine anderen Angaben gemacht werden, führen Sie alle Befehle im Arbeitsfenster 1 aus.

Window Tile, Cascade, etc.: Layout verändern

was Wählen Sie im Menu "Window" "Tile". Die beiden Fenster werden gleich gross nebenein-
ander plaziert, so dass sie die ganze zur Verfügung stehende Fläche ausnutzen. Wählen
Sie nun Menu "Window" "Cascade". Jetzt erscheinen die beiden Fenster hintereinander
gestaffelt.

bem In diesem Layout können Sie durch klicken auf die Rahmen die Fenster abwechselnd in den Vordergrund bringen.
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was Für dieses Tutorial sollten Sie das Arbeitsfenster 2 so verkleinern, dass es etwa ein Viertel
der Fläche einnimmt. Dazu fahren Sie mit dem Cursor über die Ecke des Fensters. Wenn
sich der Cursor in einen diagonalen Pfeil verwandelt, können Sie mit der linken Maus-
taste auf den Rand klicken und die Grösse des Fensters verändern, ähnlich wie Sie das
auch bereits von den Fenstern der Indigo Magic Oberfläche kennen.

bem Das Arbeitsfenster 1 können Sie nun noch ganz öffnen, wenn Sie auf das "maximize” Icon rechts oben in seinem Rand klicken.
Allerdings poppt es dadurch auch in den Vordergrund. Um das Arbeitsfenster 2 wieder in den Vordergrund zu holen, ohne das
vordere zu verschieben, können Sie es im unteren Teil des Menus "Window", in dem alle offenen Fenster aufgeführt sind,
anwählen.

FIT VIEW: Ganze Zeichnung ins Fenster einpassen

wo In beiden Fenstern finden Sie links unten in der Panoramaleiste eine Reihe mit den
wichtigsten "view control” Icons, die Sie schon aus dem
ersten Tutorial kennen.

was Wählen Sie zuerst im Arbeitsfenster 2 das Icon Fit View,
um die ganze Zeichnung ins Fenster einzupassen.

Rotate View: Blickrichtung verändern

wo Im Arbeitsfenster 2
was Aktivieren Sie den Befehl Rotate View.

In der Options Dialogbox ist der default Wert Dynamic eingestellt. Wenn Sie ihn (durch
Klicken ins Arbeitsfenster) ausführen, erscheint das Drahtmodell eines Kubus, den Sie
durch Ihre Mausbewegung drehen können. Sobald Sie Ihn loslassen wird auch das
Modell "gedreht” dargestellt.

bem Effektiv haben Sie nicht das Modell, sondern Ihre Blickrichtung darauf gedreht. Sie können sich jetzt jedenfalls davon
überzeugen, dass es sich tatsächlich um ein dreidimensionales Modell handelt, welches Sie in diesem Tutorial bearbeiten. Die
Darstellung, die Sie gewählt haben ist höchstwahrscheinlich wieder eine Axonometrie, also der allgemeine Fall einer
Orthogonalprojektion.

Rotate View: Topview (Plandarstellung)

wo Im Arbeitsfenster 2
was Der Befehl Rotate View  ist immer noch aktiviert.

Stellen Sie nun in der Options Dialogbox den Wert für Method auf Top und klicken Sie in
das Arbeitsfenster 2. Das Modell erscheint nun direkt in Plandarstellung.

bem In der gleichen Weise können Sie auch Isometrien, Front und Seitenansichten erstellen.

VIEW SAVE: Speichern einer Ansicht

wo In der Dialogbox "Saved Views".
was Wählen Sie View "2" und Dest View "2". Speichern sie diese Ansicht unter dem Namen

[plan], Description [plan_view] ab. Schliessen Sie die Dialogbox.

Grid und Snap: Einstellen

wo Im Arbeitsfenster 2 (Topview)
was Stellen Sie unter "Settings" "View Attribute" den Grid für das kleine Fenster an und

schalten Sie den Grid Snap ein (Statuszeile unten rechts, über das Icon Sperren).
Schliessen Sie das Arbeitsfenster 2 und die Dialogbox "View Attributes".

bem Sie können auch in der Axonometrischen Darstellung den Grid darstellen. Das ist aber etwas verwirrend, da die Darstellung des
Grids sich in MicroStation immer auf eine Ebene parallel zur Bildebene bezieht. Da dies im Fall der Axonometrie nicht auch
unsere Konstruktionsebene ist, verwirrt dort der Grid mehr als er als Orientierungshilfe dient.
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WCS: In das Weltkoordinatensystem zurückkehren

Bevor Sie damit beginnen, die Cellen einzusetzten, müssen Sie sicher gehen, dass Sie sich im Welt-
koordinatensystem befinden.

wo Im Menu "Utilities" "Auxiliary Coordinates"
was World Coordinate System (WCS) wählen und mit attach bestätigen. Lassen Sie die

Dialogbox geöffnet, da sie später noch gebraucht wird.
bem Das in dieser Zeichnung vordefinierte WCS entspricht dem Top View Koordinatensystem mit (0,0,0) als Originpoint.

Da in  einer neuen Zeichnung ("File">"New") noch kein WCS abgespeichert ist, empfiehlt es sich, dieses gleich zu Beginn
festzulegen.

CELL SELECTOR: Starten

Die vier Elemente, die unten auf dem Bildschirm abgebildet sind, sind bereits als Cells definiert. Sie
könnten sie mit der Place Active Cell Funktion beliebig oft und mit verschiedenen Skalierungswerten
und Orientierungen in das Modell einfügen. Zunächst muss aber eine Cell Library geladen sein.

was Aktivieren Sie im "Utilities" Menu den "Cell Selector".

Jetzt erscheint der Cell Selector .

Auf den Icons erkennen Sie dieselben Elemente, die bereits in der Zeichnung eingesetzt
sind.

bem Mit den Menus im Cell Selector können Sie jederzeit weitere Cells laden oder die bisherige Auswahl wieder löschen. Falls keine
Cell Library mit einer Zeichnung verbunden ist, erscheint das erste Mal, wenn Sie den Cell Selector öffnen, eine Dialogbox, in
der Sie aufgefordert werden, eine zu bestimmen. In der Tutorial Zeichnung ist dies nicht nötig.

PLACE ACTIVE CELL: Cell "wedge” einfügen

was Sie werden jetzt die Komposition, die sich im oberen Teil des Zeichenfensters befindet,
nachbauen. Zuerst klicken Sie auf das "wedge" Icon. In der Options Dialogbox lösen sie
den Scale-Lock (Schloss-Symbol) indem Sie darauf klicken. Jetzt können Sie die
Skalierungswerte einzeln eingeben: [X: 7.00, Y: 1.5 Z:1.0]. Die Options-Dialogbox sollte
jetzt folgendermassen aussehen:

wie Machen Sie folgende Eingabe im "key-in" Feld: [xy= 3,4]. Bestätigen Sie die Eingabe mit
der Return Taste - der wedge wird jetzt plaziert. Schliessen Sie den Befehl mit der linken
Maustaste ab.

bem Um "Input Focus" in der key-in Zeile zu bekommen, können Sie entweder mit der Maus hineinklicken oder die escape Taste
drücken.

ACS: Auxiliary Coordinate System

Das Auxiliary Coordinate System ermöglicht Ihnen, die Lage des Koordinatensystems und damit
auch der Konstruktionsebene frei zu definieren. Sie können ein ACS auf Grund von einem Element,
auf Grund von drei Punkten, mit der Blickrichtung oder als Drehung oder Verschiebung relativ zum
aktiven ACS definieren.

was Unter "Tools" die Toolbox "Auxiliary Coordinate System"
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öffnen und das zweite Icon: Define ACS (by Points)  anklicken.

In der Status-Zeile links unten werden Sie nun aufgefordert,
einen Punkt als Ursprung des neuen ACS zu definieren. Wählen Sie zuerst die linke
untere Ecke der Wedge mit der mittleren Maustaste (Tentative Point) an und nehmen,
wenn das Fadenkreuz auf die Ecke gesnapt hat, den Punkt mit der linken Maustaste an.
Klicken Sie weiter auf die untere rechte Ecke und bestätigen Sie. Als letzten Punkt wählen
Sie eine Ecke auf der oberen Kante des Keils.

bem In der Statuszeile steht jetzt, "new ACS defined". Ansonsten sehen Sie keinen Unterschied zu vorher.

ACS TRIAD: ACS graphisch anzeigen

was Im Menu "Settings" > "View Attributes" (Ctrl B) öffnen und "Acs Triad" aktivieren. Ihr neu
definiertes Koordinatensystem sollte dargestellt werden.

bem Das Logo ist zwar ganz illustrativ aber nicht sehr ansehnlich. Wir empfehlen deshalb, dass Sie es wieder ausschalten. Schliessen
Sie die Dialogbox "View Attributes".

ACS: Selbstdefiniertes Koordinatensystem speichern

wo In der Dialogbox "Auxiliary Coordinate System"
was Geben Sie den Namen [wedge] und die Beschreibung [3 point] ein. Speichern Sie.

WCS: In das Weltkoordinatensystem zurückkehren

wo "Utilities" > "Auxiliary Coordinate System"
was World WCS wählen und mit attach bestätigen.

CREATE CELL: Ein Element als Cell abspeichern

Sie werden nun in der bestehenden Cell Libary ein weiters Element
einfügen. Dafür benötigen Sie eine weitere Toolbox. Öffnen Sie unter
"Tools" > "Main" die Toolbox "Cells"

wie Selektieren Sie die rote Pyramide in der unteren Elementreihe.

Wählen Sie in der Toolbox "Cells" das Icon Define Cell Origin.

Klicken Sie mit der mittleren Maustaste auf die untere linke Ecke der Pyramide, und
bestätigen Sie den Punkt mit der linken Maustaste.

bem Sie haben jetzt das neue Element bestimmt und Cell Ursprungspunkt definiert. Nun müssen Sie das Element noch in der Libary
eintragen.

wo Im Menu "Element", "Cells"
wie In der Dialogbox wählen Sie "create". Geben Sie als Name [pyram] ein und als Beschrei-

bung [a red pyramid], bestätigen Sie mit "create". Schliessen Sie die Dialogbox.
bem Die Buttons im Cell Selector werden nicht automatisch aktualisiert. Löschen Sie daher zuerst die aktuelle Library

(Edit>clear Configuration) und laden anschliessend die neue Version (File > Load Cell Library).

PLACE ACTIVE CELL: Cell "pyramid" einfügen

was Klicken Sie auf das "pyramid" Icon (Skalierung [X: 1.5, Y: 1.5, Z:1.5]). Führen Sie alle
nötigen Befehle aus, um die Pyramide dem Muster entsprechend nachzubilden.
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ACS: Rotation des Koordinatensystems

wo ACS Toolbox

was Um das ACS für den Kubus zu definieren, starten Sie die

Funktion Rotate Active ACS

Geben Sie in der Dialogbox folgende Werte ein [35°, 0°, 0°] - wählen Sie "absolut". Sie
müssen das Koordinatensystem noch ein zweites Mal drehen - geben Sie also die folgen-
de Werte [0°, 45°, 0°] ein und wählen Sie "relativ", bestätigen Sie mit "done". Speichern
Sie das neue ACS als [cube] [rotated] in der Dialogbox "Auxiliary Coordinate System" ab.

PLACE ACTIVE CELL: Cell "cube" einfügen

was Das "cube" Icon wählen [Skalierung X: 1.0, Y: 1.0 Z:1.0], mit der mittleren Maustast die
Spitze der Pyramide auswählen und bestätigen. Schliessen Sie den Befehl mit der rechten
Maustaste ab.

ACS: Vordefiniertes ACS nochmals abrufen

wo In der Dialogbox "Auxiliary Coordinate System"
was Wedge ACS wählen und mit attach betätigen.

PLACE ACTIVE CELL: Cell "con" einfügen

wie Wählen Sie das Icon "con". Geben Sie folgende Skalierungswerte ein: [X: 1.00, Y: 1.8
Z:1.0]. Klicken Sie mit der mittleren Taste auf die untere linke Ecke des wedge, bestäti-
gen Sie mit der linken Maustaste. Schliessen Sie den Befehl mit der rechten Maustaste
ab.

LEVEL: Aktivieren

Die Nummer der aktuellen Ebene steht oben links auf der Statuslinie des Graphikfensters. Ebene 1
sollte jetzt aktuell sein. Sie können über die Statuslinie eine neue aktive Ebene wählen.

was Auf der Statuslinie die Ebene 2 als aktive Ebene wählen, indem Sie mit dem Curser auf
die Zahl klicken, und in dem Fenster "2" wählen.

bem Die aktuelle Ebene (die Ebene, in dem jetzt Elemente erzeugt werden) ist jetzt die Ebene 2

LEVEL: Name

In MicroStation wird die aktuelle Ebene in Form einer Zahl angegeben, MicroStation verfügt über
63 Ebenen. Sie können jeder dieser Ebenen einen Namen geben.

wo "Settings" > "Level" > "Names". Das Fenster "Level Names"
wird geöffnet.

was Klicken Sie auf "Add", machen Sie nun folgende Eingaben: Number [2], Name [text],
comment [Beschriftung], bestätigen Sie mit "OK". Schliessen Sie die Dialogbox mit
"Done".

bem Die Namensgebung für die einzelnen Ebenen ist auch über "Settings" > "Level" > "Display" möglich.
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PLACE TEXT: Text schreiben

wo main Toolbox

was Starten Sie den Befehl Place Text.

Es werden zwei Fenster geöffnet, geben Sie
im text editor  Ihren Namen ein.

Wählen Sie einen Punkt auf der schrägen Ebene des Keils und plazieren Sie den Text. Um
die Funktion Place Text zu beenden, klicken Sie auf das Icon Element Selector.

bem Ein Text wird wie alle 2D-Elemente planar zur entsprechenden Ansicht plaziert. Stellen sie sicher, dass sie sich im WCS-Wedge
befinden.

HIDE: Verdeckte Kanten wegrechnen

wo "Utilities" > "Render" > "Hidden Lines "
was Klicken Sie ins Arbeitsfenster 1, die verdeckten Kanten werden in dieser Ansicht weg-

gerechnet.

Save Image: Abspeichern von Bild 1

was Abspeichern von Bildern
wo Wählen Sie unter "Utilities" > "Image" > "Save".
wie Das Fenster "Save Image" wird geöffnet. Stellen Sie das Format auf "JPEG" und  das

Shading auf "Hidden Line" ein. Lassen Sie alle anderen Einstellungen unverändert und
speichern Sie das Bild als a2_nachname1.jpg ab.

bem Sie haben das aktuelle Bild in dem Graphikfenster abgespeichert. Es ist als a2_nachname1.jpg in Ihrem Directory abgelegt.

WCS: In das Weltkoordinatensystem zurückkehren

was Kehren Sie wieder in das Weltkoordinatensystem zurück. Schliessen Sie die Dialogbox.

CHANGE ELEMENT ATTRIBUTES: Eigenschaften ändern

Mit dem Befehl Change Element Attributes können gewisse Eigenschaften der Elemente verändert
werden.

wo Main Toolbox
was Starten Sie das Icon Change Element Attributes,

Aktivieren sie das Kästchen neben "Weight" und geben Sie den Wert "1" ein - es wird nur
dieses Attribut geändert. Klicken Sie mit der linken Maustaste auf Ihren Namen und
bestätigen Sie mit der linken Maustaste. Schliessen Sie die Dialogbox.

bem Sie werden merken, dass Ihr Name jetzt dicker, wie bei dem Mustertext, erscheint.
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LEVEL: Aktivieren

was Aktivieren Sie wieder die Ebene 1.

LEVEL: Name

was Geben Sie der Ebene 3 den Namen muster.
bem In MicroStation gibt es defaultmässig 63 Ebenen, Sie müssen also nicht neue Ebenen definieren.

LEVEL LOCK: Ebene sperren

Wenn Sie die Ebenensperre aktiviert haben, können Sie nur mit Elementen arbeiten, die sich auf
der aktiven Ebene befinden.

wo Statusleiste rechts

wie Wenn Sie das Icon sperren  aktivieren,

erhalten Sie direkt Zugriff auf das Untermenü "Locks" - wählen sie "level"

LEVEL: Ebenenfarbe ändern

In MicroStation können Sie sämtliche Attribute auch über die Ebene definieren. Sichtbar werden
diese Attribute jedoch erst, wenn Sie unter "View Attributes" "Level Symbology" aktivieren und mit
apply anwenden.

wo "Settings" > "Level" > "Symbology"

was In der erscheinenden Dialog Box  wählen Sie die Ebene,
bei der Sie die Attribute ändern möchten. Geben Sie die
Attribute ein und bestätigen Sie mit "apply".

bem Normalerweise werden alle Attribute überschrieben, Sie können jedoch auch einzelne Attribute deselektieren.

LEVEL: Level ändern

Es gibt zwei Möglichkeiten, um Elemente auf einer neuen Ebene zu plazieren. Über die Element-
attribute oder durch Selektieren und Wechseln der aktivem Ebene.

wie Selektieren Sie die Elemente, ändern Sie die aktive Ebene in der primären Symbolleiste -
in unserem Fall auf die Ebene 3.
oder:
Wählen sie das Icon Change Element Attributes

Aktivieren Sie "Levels" im Funktionseinstellungsfenster, geben Sie die Nummer der Ebene
ein (in unserem Fall 3), auf die die Elemente verschoben werden sollen, sie wird jetzt zur
aktiven Ebene. Selektieren Sie die Elemente des Vorgabemusters (Mehrfachauswahl mit
ctrl-Taste). Bestätigen Sie die Änderung.
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LEVEL: On und Off

wo "Settings" > "Level" > "Display"

wie Wählen Sie in der Dialog Box "Display" "Level Numbers".
Das Fenster sollte dann so aussehen.  Wenn Sie einmal
auf eine Ebenennummer klicken, erscheint Sie weiss und
ist ausgeschaltete, klicken Sie zweimal darauf wird Sie
zur aktiven Ebene, symbolisiert durch einen Kreis. Bestä-
tigen Sie mit "apply"

bem Sie können die Ebenendarstellung für jedes Arbeitsfenster separat einstellen.
Wählen Sie dafür die ensprechende View Number.

LAYER: Off

was Benützen Sie die Dialogbox "View Level" um das Muster unsichtbar zu machen.

SHADE: Flächen schattieren

Für den letzten Teil des Tutorials benötigen wir Funktionen der Toolbox "Tools">"3D">"3 D View
Control". Öffnen Sie diese und docken Sie sie seitlich an das Zeichenfensters an.

wo Toolbox "3-D View Control"

was Klicken sie auf das Icon Render,

wählen Sie in der Dialogbox "Target" -> View, "Render Method" -> Filled Hidden Line,
"Shading Type" -> Normal und klicken Sie in das gewünschte Fenster.

UPDATE VIEW: Bildschirminhalt neuzeichnen

was Update View Icon anklicken
bem Update View regeneriert die Darstellung des Modells. Es ist nötig, den Update View-Befehl (oder einen anderen, der automatisch

Update View ausführt) nach Render auszuführen, um weiter am Modell arbeiten zu können, da sonst keine Selektion möglich
ist.

LAYER: On

was Alle Ebenen wieder sichtbar machen - schliessen Sie die Dialogbox "View Level".

Camera: Perspektiven definieren

Um das Erstellen von Perspektiven zu vereinfachen, kehren Sie wieder zum abgespeicherten
plan_view zurück.

wo "Utilities" "Saved Views"
was Wählen Sie in der Dialogbox "plan" und bestätigen Sie mit "apply".
bem Achten Sie darauf, dass als Dest View die Ansicht 1 eingetragen ist und alle Elemente im Fenster sichtbar sind (Fit View).

wo Toolbox "3 D View Control"

wie Klicken Sie auf das Camera Icon.
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Selektieren Sie zuerst die Ansicht, indem Sie in das Arbeitsfenster 1 klicken. Legen Sie in
der Dialogbox folgende Angaben fest: "Camera Setting" -> Set Up, "Image Plan
Orientation" -> Perpendicular, "Standard Lens" -> Normal.
Wählen Sie die obere rechte Ecke des Musters mit der mittleren Maustaste als
Target(Ziel)Punkt und bestätigen Sie den Punkt mit der linken Maustaste, wählen Sie
dann analog die Mitte der unten links stehenden Pyramide als Camera Position. Mit Fit
View sind alle Elemente wieder im sichtbaren Bereich.

bem Da Perspektiven nicht ganz einfach zu erstellen sind, ist es eine gute Idee, die einmal definierten Perspektiven mit einem View
Name abzuspeichern.

VIEW SAVE: Ansicht speichern

was Speichern Sie die neu definierte Perspektive in der Dialogbox "Saved Views" unter dem
Namen [per1], Description [2 point] ab.

DVIEW: Perspektiven definieren

Sie werden jetzt eine Perspektive definieren, deren Bildebenenausrichtung "Parallel zur z-Achse" ist,
was bei der Bearbeitung architektonischer Renderings nützlich ist, da so sichergestellt wird, dass
die Objekte unabhängig von der Kameraposition senkrecht angezeigt werden.

was Kehren Sie wieder zum plan view zurück, aktivieren Sie die Camera, stellen Sie bei
"Image Plan Orientation" -> Parallel to Z Axis ein, die anderen Angaben bleiben unverän-
dert. Wählen Sie die Ansicht, stellen Sie den Snap auf "Midpoint" und klicken Sie mit der
mittleren Maustaste auf die obere Kante des ersten Keils, bestätigen Sie den Punkt mit
der linken Maustaste. Gehen Sie analog vor, um den Mittelpunkt auf der unteren Linie
des zweiten Keils einzugeben. Mit Fit View wieder alle Elemente in den sichtbaren
Bereich bringen.

VIEW SAVE: Ansicht speichern

was Speichern Sie die neu definierte Perspektive in der Dialogbox "Saved Views" unter dem
Namen [per2] ab, geben Sie als Description [parallel z] ein.

Save Image: Abspeichern von Bild 2 und 3

was Machen Sie je ein Save Image von den per1 und per2 Views [a2_nachname2.jpg und
a2_nachname3.jpg]. Führen Sie bei beiden zuerst entweder "Hidden Lines" oder "Filled
Hidden Line" aus.

END: MicroStation verlassen

wie Wählen sie unter "File" > "exit"


